Movie Maker

What you will need

Video camera

Computer (note: if your camera is not USB then you will need a Firewire (IEEE 1394) port on your
computer

Microphone

Headphones

It is also recommended that you create a storyboard prior to creating your video. This will help you gather all the
media you need beforehand.

Step 1: Aquire Media - Video, Audio and Photos/Images

You can capture video directly from your video camera or import video, images and audio that already exists on
your computer or external drive.

Download from a Video Camera

For more detailed directions check out Microsoft's site:
http://www.microsoft.com/windowsxp/using/moviemaker/getstarted/DLmovies.mspXx

How to download video using an FireWire/IEEE 1394 connection

1.
2.

Connect your digital video camera to your computer using an Firewire cable.

Turn your camera on, and set it to playback mode. When prompted, click Capture Video using
Windows Movie Maker. Then click OK.

Microsoft Windows Movie Maker starts the Video Capture Wizard. On the Capture Video File page,
type a name for your video. Then click Next.

. On the Video Setting page, accept the default settings by clicking Next.

. On the Capture Method page, click Next. It's easiest to capture the entire tape at once; if sections

remain that you don't need, you can delete them later.

. The Video Capture Wizard rewinds your tape and then begins capturing it. While the tape is being

captured, you'll see it playing in the Preview window and you'll be able to hear the audio through your
speakers. After the tape is captured (this usually takes about an hour), the wizard will stop
automatically. It always scans the entire tape, even if you have just recorded a few minutes of video.

If you reach the end of your recording before it reaches the end of your tape, click the Stop Capture
button, and then click Yes. Movie Maker automatically breaks your movie into clips and adds the clips
to a video collection with the name you provided. Now you're ready to edit your movie.

How to download video using a USB or analog connection

Though a USB cable or analog video connection is nhot as easy to use as an i.Link connection, you can
still download video to your computer by manually rewinding your camera, pressing the play button,
and then starting the capture.

1.
2.

Connect your digital video camera to your computer using a USB cable or analog video connection.

Start Movie Maker by clicking Start, pointing to All Programs, and then clicking Windows Movie
Maker.


http://www.microsoft.com/windowsxp/using/moviemaker/getstarted/DLmovies.mspx

3. In the Movie Tasks pane, under Capture Video, click Capture from video device.

4. Movie Maker starts the Video Capture Wizard. On the Video Capture Device page, click your camera.
Then click Next.

5. On the Capture Video File page, type a name for your video. Then click Next.
6. On the Video Setting page, accept the default settings by clicking Next.

7. On the Capture Video page, use your video camera to rewind or fast-forward to about five seconds
before the start of the clip that you want to download. Then press the play button on your video
camera, and immediately click the Start Capture button in the Video Capture Wizard. It's okay if you
start capturing too early, because you can trim the beginning of the clip later.

8. Click Stop Capture at the end of your clip. It's also okay to capture the entire tape at once, because
you can break it into shorter clips later.

9. Repeat steps 7 and 8 to capture other clips. When you're done, click Finish. Movie Maker automatically
breaks your movie into clips and adds the clips to a video collection with the name you provided.

Import Photos/Images

1. On the File menu, click Import into Collections.
_Or_

2. In the Movie Tasks pane, under Capture Video, click Import pictures.

3. In File name, enter the path and file name of the file you want to import, and then click Import.

Note: You can import several files at one time. For consecutive files, click the first file in
the list, press and hold down the SHIFT key, and then click the last file in the list. For files
that are not consecutive, press and hold down the CTRL key, and then click each file that
you want to import.

Import Audio/Music

1. On the File menu, click Import into Collections.
_Or_

2. In the Movie Tasks pane, under Capture Video, click Import audio or music.

3. In File name, enter the path and file name of the file you want to import, and then click Import.

Note: You can import several files at one time. For consecutive files, click the first file in the list, press
and hold down the SHIFT key, and then click the last file in the list. For files that are not consecutive,
press and hold down the CTRL key, and then click each file that you want to import.

Once you have imported all of your media files they will display in the main Collections window.

Step 2: Building the Video

Building a video includes:

e editing video clips

adding video and images

adding special effects

adding titles

adding transitions

adding background music

adding voiceover



Editing Video using either the Trim or Split options

1. Begin by dragging the appropriate clip to the clip Timeline. Note: if you are in Storyboard view you will
need to change to Timeline view by clicking on Show Timeline

2. Trimming clips

1. By trimming clips, you can edit the starting and ending point—and therefore the length—of
any video or audio clips that you have added to your project on the timeline. When trimming,
you can set the start and end trim points. The start trim point determines when the clip will
begin to play, and the end trim point determines when the clip will stop playing in your
project.

2. By trimming clips, you can hide unwanted parts of an audio or video clip or file. When you
trim a clip, the information is not removed; it is hidden from your audience, so unwanted
parts do not appear in your project and final saved movie. You can drag the trim handles,
which are shown in the following illustration, to trim the unwanted parts of the clip.
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3. Note: The playback time for video and audio clips cannot be extended.

To split a video or audio clip

1. Begin by dragging the appropriate clip to the clip Timeline. Note: if you are in Storyboard view you will
need to change to Timeline view by clicking on Show Timeline

2. In the Contents pane or on the storyboard/timeline, click the clip you want to split.
On the Play menu, click Play Clip, and then click Pause Clip on the Play menu to pause the video at
the point you want to split the clip.
_or-

3. On the monitor, move the playback indicator on the seek bar to the point you want to split the clip.

4. On the Clip menu, click Split.

Adding images



1. From the Contents area click the image you want to use and drag it into the Storyboard or Timeline
at the bottom of the window.

Adding Transitions
Transitions help your video flow from one clip to another. Similar to transitions in PowerPoint.

Begin in Storyboard view. If you are in Timeline view click on Show Storyboard to switch.
In the Movie Tasks pane, under Edit Movie, click View video transitions.
Identify the transition you want to use.

Click, hold and drag the transition between two media clips.
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To delete the transition select it in the Storyboard View and press the Delete key on the keyboard.

Adding Video Effects
Video Effects can be applied to video or images.

Begin in Storyboard view. If you are in Timeline view click on Show Storyboard to switch.
In the Movie Tasks pane, under Edit Movie, click View video effects.
Identify the video effect you want to use.

Click, hold and drag the effect onto the star icon of a media clip.
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To delete the video effect select it in the Storyboard View and press the Delete key on the keyboard.
Adding Titles/Credits

1. Begin in Timeline view. If you are in Timeline view click on Show Timeline to switch.

2. In the Movie Tasks pane, under Edit Movie, click Make titles or credits.

3. Different title types have different settings. Identify the title type you want to use.

1. Note: if you choose title before, on, or after the selected clip make sure you have a clip
selected first.

2. You can change the title animation, the title color and the font.

4. When finished click Done, add title to movie. Note: make sure to click the (+) sign next to Video in
the Timeline View because some titles show up on a different line.

5. To delete the video effect select it and press the Delete key on the keyboard.
6. To edit it double-click it to re-open the edit window.
Add music

1. In the Movie Tasks pane in Movie Maker, under Capture Video, click Import audio or music.

2. In the Import File dialog box, click the name of the song you want to use in the background. Then
click Import. This adds your song to your collection but does not add it to your video.

3. Drag the song from the collection to the video clip where you want the music to start playing.
4. If prompted, click OK.

5. Movie Maker shows your song on the timeline. If the song extends beyond the end of the movie, drag
the right edge of the song so that it ends at the same time as your movie. Otherwise, the song will keep
playing after your movie is done. It's a nice touch to have the music stop during a quiet spot so that it
doesn't just stop abruptly.



6.
7.
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Click Play in the Preview Monitor to watch your movie and listen to the background music.

If the background music is too loud or too soft in comparison to the movie, right-click the music on
your timeline, and then click Volume. If the audio and music sound good, you can skip the next step.

. In the Audio Clip Volume dialog box, move the slider to the left to make the music quieter, or to the

right to make it louder. Then click OK.

Return to step 7 to listen to the audio again and make another adjustment if necessary. Audio Clip
Volume dialog box with OK button selected

Next time you're filming video, think about the background music. For example, if you're filming a
football game, see if you can get a copy of the team's fight song. If you're on vacation, buy a CD of
local music so you can add it to your movie.

Add narration

10.
11.

12.

. If you have a desktop computer, connect a microphone. Microphones are available from most

electronics stores. If you have a portable computer, you can use the built-in microphone. However, you
will get a better-quality recording if you connect an external microphone.

. In Movie Maker, click the Tools menu, and then click Narrate Timeline.
. If prompted, click OK.

. On the timeline, click the clip you want to narrate. You can narrate clips one at a time, or you can

narrate the entire movie all at once. If you narrate individual clips, you can rearrange them later and
keep your narration synchronized.

. Speak normally into your microphone, and adjust the Input level so that the bar is about halfway up

when you are speaking.

Under Narrate Timeline click Start Narration.

. Speak into your microphone as Movie Maker plays your movie. You can narrate your entire movie at

once or just one clip at a time. When you're done narrating, click Stop Narration.

Movie Maker will save your narration as a separate file. In the Save Windows Media File dialog box,
type a name for your narration. Then click Save.

Movie Maker adds your narration to your video. If you only narrated part of your video and you want to
add narration to other clips, return to step 5.

Click Play in the Preview Monitor to watch your movie and listen to the narration.

If the narration is too loud or too soft in comparison to the movie, right-click the narration on your
timeline, and then click Volume. If the audio and narration sound good, you can skip the next step.

In the Audio Clip Volume dialog box, move the slider to the left to make the narration quieter, or
move it to the right to make it louder. Then click OK. Return to step 11 to listen to the narration again,
and make another adjustment if necessary. Audio Clip Volume dialog box with OK button selected.



If you don't like the way your narration sounds, don't worry—nobody likes to hear their own voice. Just
relax and speak in a normal tone, as if you were telling a friend on the phone about your movie. It may
take you a few tries to get the timing right so that your narration doesn't go on longer than your movie.
If you misspeak often, it might help to write a script that you can read during the narration.

13. To delete narration so that you can re-record it, right-click the narration on the timeline, and then
click Delete. You should also delete the narration from the collection.

Step 3: Making the Final Movie

When you are completely finished with your movie play it back on last time to see if it's exactly what you want.

[y

In the Movie Tasks pane, under Finish Movie, click Save to my computer.

2. On line 1 name your computer. On line 2 choose where the video should save. Click Next.
3. Choose the Best Quality radio button then click Next.
4

. When done click Finish. Your video is now saved on your computer.



